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Appendix A

Using the video capture and
analysis software

1 Capturing a video

The video camera should already be connected to the PC, pointed and focused, prior
to the lab. Please ask your instructor for assistance if the camera is not set up
correctly. Do not attempt to adjust the camera yourself.

Double click on the ‘Video Capture’ icon on the desktop to start the camera. You
should get something like what is shown in Fig. A.1, with a real-time display of the
camera’s image.

Figure A.1: Video capture software.

The camera software will start storing video images when you click on the red
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‘record’ button. You can record approximately 40 seconds of video; when recording
for a longer period of time, only the last 40 seconds are kept. When recording the
display will only refresh a few times per second; don’t worry, it’s storing the complete
video.

Click the ‘record’ button again to stop recording. Then click on the ‘disk’ button
(or the ‘File/Save As..." menu) to save the video in your Documents folder. The file
will be saved as a multi-image TIFF file.

2 Analyzing video clips

Double click on the ‘Scion Image’ icon on the desktop to start the video analysis
software. It will create several windows on your desktop.

You will first have to import the video file and find the images that you want to
analyze. You will then need to calibrate so that positions in the image are in ‘length’
units (centimeters, etc.) rather than ‘pixels’, measure positions, then copy your data
to an Excel spreadsheet.

2.1 Opening the video file

Use the ‘File/Import..." (not ‘File/Open’) menu to load your video into Scion, making
sure that the TIFF button is selected. A window will appear with your video, and
quickly animate your video as the file is loaded.

2.2 Moving around

Each frame of your video will appear as a separate image in what Scion calls a ‘stack’
of images (slices). You can use the ‘Stacks/Next Slice’ (or ‘Previous Slice’) menu to
move to between images in the stack. The period and comma keys on the keyboard
will also move between slices, and holding down the SHIFT key while pressing period
or comma will move between slices quickly.

Note that the date and time of when the image was captured is displayed at the
bottom of each image. For most of the labs, the video frames should be 1/30 sec apart
(30 frames per second), but you should check the capture times to be sure.

You can use the ‘Magnifier’ tool to enlarge the image (see Fig. A.2); just select
the magnifying glass tool and click on the image at the point you want to zoom in
on. To return to an unzoomed view, either use the ‘Edit /Unzoom’ menu, control-U,
or hold the control key while clicking with the magnifier tool.
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Figure A.2: (a)Scion tools, and (b)dialog for setting the image scale
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Use the ‘Hand’ tool to scroll the image in the image window.
When you're trying to get a measurement accurately, working with a zoomed
image is very useful.

2.3 Image Calibration

We will need to convert distances in the images (in pixels) to real world distances
(meters), which we will do by calibrating the image scale.

You need to select a slice that has an image of something of known length, such
as a meter stick, in the same field of view as the things that we’ll want to measure.

If you use a meter stick that is closer or further than the object you’re measuring,
then it will appear larger or smaller and throw off the calibration. Similarly, if the
camera is moved or turned, the images will have to be re-calibrated.

From the ‘“Tools’ window (see Fig. A.2(a)), select the line selection tool (we want
the ‘straight line’ tool, which is what you should get by default).

Click and hold on one end of the ‘known object’, drag to the other end of the
object, and release. There should be a flickering (‘marching ants’) line across your
object, with dots at the two ends and middle. While you're doing this, the ‘Info’
window should display a length.

While using the line selection tool, you can click on one of the end dots and move
the endpoint of the line; this can be very useful when measuring in a magnified view.

From the ‘Analyze’ menu, select ‘Set Scale...” (see Fig. A.2(b)). This will have
a dialog with ‘Measured Distance’ (it should already be filled with the length of the
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Figure A.3: The Options /Preferences dialog; checking the ‘Invert Y Coordinates’ box
makes y coordinates increase upwards.
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line you just drew), ’Known Distance’, etc.

Assuming that the Measured Distance is right, fill in the value for the Known Dis-
tance, and pick the value of the Known Distance from the menu (example: Measured
Distance is 62 pixels, Known Distance is 50 with units of ‘centimeters’).

For these cameras, the Pixel Aspect Ratio is 1.0, so you shouldn’t have to change
that.

The dialog should then calculate the scale in pixels per meter or centimeter. Click
‘OK’ to use this scale.

After you set the scale, the ‘Info’ window should display X and Y positions both
in ‘real’ units and in pixels.

Now double-check your calibration by measuring a known length again; the ‘Info’
window should show you the calibrated length. If not, do the calibration again.
There’s occasionally a problem (a software bug?) that results in the first calibration
being ignored, so double check.

By default, Scion measures Y values increasing downward; this is usually not
what we want. From the ‘Options’ menu, select ‘Preferences...’ and click the ‘Invert
Y Coordinates’ box (see Fig. A.3).

2.4 Measuring Positions

To measure positions, first select the ‘Analyze’ menu, ‘Options...” dialog. Have the
X-Y Center’ box checked, and all the other boxes unchecked. Select the ‘Analyze’
menu 'Show Results’ and a Results menu will be shown.
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Time [s] | X [cm] | Y [cm]
39.781250 | 35.03 8.95
39.828125 | 34.76 9.23
39.859375 | 34.53 9.46
39.890625 | 34.25 9.68
39.921875 | 33.97 9.96
39.953125 | 33.75 10.24
39.984375 | 33.47 10.52
40.015625 | 33.24 10.80
40.062500 | 32.91 11.08
40.093750 | 32.68 11.31
40.125000 | 32.35 11.59
40.156250 | 32.07 11.81
40.187500 | 31.84 12.03
40.218750 | 31.56 12.31
40.250000 | 31.29 12.59
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Table A.1: Example 2D motion data
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Figure A.4: Example video frame with position measurement
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Appendix B

Fitting and plotting data

1 Introduction

Graphical presentation (a ‘plot’) of your data is a very powerful tool to help yourself
and others understand your results and draw conclusions from them.

For example, a simple qualitative question like ‘does B change when I change A7’
can be answered by graphing measurements of B taken with different values of A.

A graph will also show how strongly B varies with a change in A, whether the
value of B is a linear function of A (or perhaps a polynomial, an exponential, or some
other function), what ranges of A and B were examined, and possibly the amount of
error in the measurements.

While fitting and plotting data is a task for which a computer program is nearly
an ideal tool, programs need human guidance to make sure that the resulting graph is
clear and easily comprehensible. To give one example: graphs produced in Excel often
have poor choices for the axis limits and require manual adjustment of the limits.

As a general rule, you want to adjust your graph scales so that all of your data
(and any other ‘points of interest’) are easily visible, and to exclude ranges that do
not have data. If the useful information in a graph is the slope of your data points,
make sure that the scale is such that the slope can be seen; it doesn’t have to be right
at 45°, but should have some significant visual slope, rather than being compressed
to horizontal or vertical by the scaling.

Similarly, you want to make sure that the axes have informative labels (with
units!) and that the numeric scale has clear values. For example, having ‘1.00000’
on an axis has far too many zeros if the next value is ‘2’, but not if the next value is
1.00005’.
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This appendix has some general guidelines for how to handle and present your
data. But for every ‘rule’ there are numerous exceptions. The most important rule is
that you should handle and present your data in a way that clearly, accurately and
honestly illustrates what you did. If you have to switch dependent and independent
axes (for example) to best illustrate your results, then by all means do so.

There are many tools for fitting and plotting available, but here we will focus
on two: the graphing capabilities of Microsoft Excel, and some CGI-based utilities
available on the lab homepage (http://www.physics.drexel.edu/labs/).

2 Data

The data that goes into your graphs will have a set of data points, typically an ‘z’
value horizontally, which is most commonly an ‘independent’ variable, or a value that
you control, and a y value vertically, which is most commonly a ‘dependent’ variable
that you measure as a result.

When the lab procedure asks you to plot ‘foo’ ws. ‘bar’, that generally means
that ‘foo’ is the dependent variable (vertical), and ‘bar’ is the independent variable
(horizontal).

Measurements always have some error, but if the error is small or all of the data
points have the same amount of error, one can often leave off ‘error bars’ on the data
points in a graph. The benefit of leaving the error bars on is that it is clear how much
one can trust each data point, and when fitting data it allows estimates to be made
of the error in the fit parameters.

In the remainder of this appendix, we’ll assume that x is an independent variable
with negligible error, y is the dependent variable, and dy is the measurement error in
y. Your data points are then a list of ordered set (z,y, dy) values.

3 Fitting and Plotting with Excel

When you need to do calculations with your data before plotting, a spreadsheet like
Excel is a very useful tool for doing the calculations. One can also do acceptable
graphs with Excel, at least in many cases.

Excel does have the drawback that it is very difficult to get it to handle data with
errors correctly, so if you need plots of data points with error bars, go ahead and use
Excel for your calculations but use the CGI-based utilities for fitting and plotting.

To do a simple plot in Excel, put your z and y data into two columns. Click and
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hold to select the areas for the z and y data points (hold down Control while clicking
to add non-contiguous cells). Then either click on the menu-icon that looks like a
bar chart, or from the pull down menu ‘Insert /Chart...". This will bring up the Chart
Wizard.

Step one of the Wizard is to select a chart type. Select ‘XY (Scatter)’. Then go
to Step 2.

If you've done the selection of data points correctly (and sometimes it’s just im-
possible, so read on) then there should be little picture that looks a bit like your
graph. Otherwise, select the ‘Series’ tab, add a data series if none are present, and
set the ‘X values’ to the range of cells for your z’s and ‘Y values’ for the y’s. Note
that there’s a little icon next to the entry boxes for the ‘X values’ etc. that let you
click and drag to select cells. Then go to Step 3.

Here you set titles for the chart and the X and Y axes. Make sure to put units
on the axes when applicable. Other tabs will let you turn on or off grid-lines, legends
(turn it off, usually), etc. You want your graph to be clean and informative, so get
rid of any unneeded clutter. Then go to Step 4.

Finally you have to decide whether your graph is a separate sheet or not. The
only difference it makes is if you want to print your graph on the same page as your
spreadsheet data.

Once you have your graph, you can double click on the axes to bring up the
‘Format Axis’ menu. Select the ‘Scale’ tab to adjust the maximum and minimum
values. You have to uncheck the ‘auto’ box to manually enter values for these. In
general, the only one of these that needs changed (and it often needs changed) is the
minimum value. Excel likes to use zero for the minimum, even if it makes no sense at
all. Most of the other options for the axes and chart background are just annoying
visual clutter (‘colored, angled text in AvanteGarde Bold’) and should be avoided.
The ‘Format axis’ menu is also where you can select logarithmic scaling for the axes.

To fit your data in Excel, right click on a data point and select the ‘Add Trend-
line...” option. You’ll then select one of the Trend /Regression types. Most often
youwll want ‘Linear’, but ‘Polynomial, order 2’ is useful for quadratic fits.

Before you leave the Trendline menu, select the ‘Options’ tab and click the ‘Display
equation in chart’ box. Otherwise all you’ll get is the line, and you won’t know the
values of the slope and intercept.
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4 CGI-based Fitting and Plotting

There are several fitting and plotting CGI’s available on the lab homepage
(http://www.physics.drexel.edu/labs/) for your use. First you’ll have to decide
whether or not you will be fitting and plotting with errors, and whether your fit will
be linear or polynomial. (Exponential and power-law fits can be done by using log
scaling on the axes)

All of the graphing and fitting options are on one page for the CGIs, just make
sure that you click the ‘Update’ button after making changes, and watch out for error
messages if you do something you shouldn’t (like use negative values for a logarithmic
scale).

4.1 CSV files

In the CGI, you can either type in the data values by hand, or upload a ‘CSV’
(comma-separated value) file. If you have the data in Excel, just copy the data to a
fresh worksheet using the A and B columns for z and y data (column C for dy if you
are using errors), and tell Excel to ‘Save As..’. In the ‘Save As.’ menu, select the
file type ‘CSV (Comma delimited)’ and pick a temporary file and save. Excel will
complain about not being able to save all the worksheets, but tell it to save anyway.

Then on the CGI click the ‘Choose’ button to select the CSV file, and ‘Update’
to upload your data. Your data should appear on the CGI form after the update.

4.2 Manual entry

You can enter a few data points at a time, then click ‘Update’; your data will be
entered and you’ll get several more spaces for entering data points. The ‘Action’ field
will let you change (or delete) your data points, but if you want to delete all of your
data and start over it may be better to click the ‘Start new plot’ link at the top of
the page.

4.3 Fits

In the CGI you can decide which data points to include or exclude from your fit,
whether to plot the fit line (see the ‘Legends’ area) whether to show the fit equation,
and how many significant figures to use for the fit equation.

Whether you show the fit line and equation on your plot or not, the web page
will give you the fit results. You can then download the GIF or EPS (encapsulated
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postscript) of the plot for printing or inclusion in a document.

5 Example: 2D-Motion

As an example, the data from Appendix A is fitted using the CGI software. A
spreadsheet with (¢, z) data was saved as a CSV file, and uploaded to the CGI program
shown in Fig. B.1.

As shown in Fig. B.2, the plot is quite linear, with a slope of —8.1 cm/s (rounding
to significant figures), and an intercept of 360 cm. The reason that the intercept is so
large is that the starting time is at ¢ ~ 39.5s rather than ¢ = 0; starting the times at
t = 0 would give an intercept closer to 35 cm.
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Figure B.1: Use of CGI to fit example 2D motion data
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Figure B.2: Resulting plot of example 2D motion data
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6 Final Words

Simple fitting of data, in particular linear regression, is a powerful tool for extracting
useful results from raw data. Much of the theoretical gymnastics that is done prior
to the labs is just to get an expression that has ‘the thing we want’ in the slope
or intercept of a linear equation, where the z and y are things that we control or
measure.

Whenever we do a fit of data for these labs, it is important to show that fit: print
it out, include it with the papers you turn in, make sure that the plot is clear and
easily comprehensible.

A plot will quickly tell you when things are going wrong with an experiment, and
also give a lot of confidence that things are not going wrong when the data looks
good.
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